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Preface

Page 1

This guide is written for Blackboard Collaborate web conferencing users with visual, auditory or 
motor disabilities. It describes the accessibility features intended for these users in the desktop 
version of Blackboard Collaborate.

Note: For a complete instructions on using Blackboard Collaborate, refer 
to the Participant's Guide available on the On-Demand Learning Center at 
http://www.blackboard.com/Platforms/Collaborate/Services/On-
Demand-Learning-Center/Web-Conferencing.aspx. 

See  Getting Started on page 5 for a list of which sections in this guide are relevant to your 
particular needs.

Conventions Used in this Guide

Variables
There are a few places in Blackboard Collaborate web conferencing that are populated with data 
specific to the session. Because we do not know in advance what those data (e.g., words or 
names) will be, in this guide they are represented by variables enclosed in angle brackets. For 
example, the variable <Panel Name> is used in the discussion of Restoring Default Preference 
Settings to represent the name of the currently selected panel.

http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center/Web-Conferencing.aspx
http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center/Web-Conferencing.aspx
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http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center/Web-Conferencing.aspx
http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center/Web-Conferencing.aspx


Notes
Six types of notes may be used in this guide to highlight information:

Note: Notes are used to highlight important information or to present 
asides relevant to the topic at hand.

Tip: Tips provide helpful information on how to most effectively use a 
particular feature of the product.

Caution: Cautions alert you to potentially confusing terminology or 
difficulties that may occur when using the product.

Warning: Warnings alert you to potentially serious problems.

Notes of this format are used to highlight Linux-specific information.

Notes of this format are used to highlight Mac-specific information.

Notes of this format are used to highlight  information specific to mobile 
devices (mobile phones and tablets).

Typographical Conventions

Convention Description

1.  Number Indicates a step in a task.

 o Hollow bullets Indicates that there are several options available for completing a task, but 
only one is necessary.

Bold Represents clickable elements in the user interface (e.g., text links, but-
tons, tabs, etc.). Also used to give emphasis to words.

Italics Represents menu items, options and parameters. Also used for cross ref-
erences and names of documents.

Monospace Indicates pathnames, filenames, folders and command lines.

<brackets> Indicates variables.
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Getting Help

Documentation and Learning Resources
Documentation and learning resources (for all Blackboard Collaborate products) are available on 
the On-Demand Learning Center, which can be reached as follows:

 o In your browser, enter the following address:

http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center.aspx

 o From within Blackboard Collaborate web conferencing, select Additional Documentation 
from the Help menu.

You can directly open the following documents from within Blackboard Collaborate web 
conferencing by selecting them from the Help menu:

 n Keyboard Shortcuts

 n Accessibility Guide for Participants

 n Blackboard Collaborate Essentials for Participants

Technical Support
Blackboard Collaborate technical support and the support Knowledge Base are available through 
the Support Portal:

http://support.blackboardcollaborate.com

Community
We encourage Blackboard Collaborate users of all levels (administrators, instructors and 
students) to submit questions to Ask the Doctors, a free question-and-answer forum 
moderated by an expert team of your fellow Blackboard Collaborate users.  Their goal is to 
provide quality answers to your questions in a highly responsive manner, while building a global 
knowledge base for online teaching and learning. 

You can find Ask the Doctors at the link below:

http://discussions.blackboard.com/forums/default.aspx?GroupID=9

Messages posted in the Ask the Doctors forum do not go to our Support Team. If you require 
technical support assistance to resolve a problem, please contact Technical Support (see the 
headingTechnical Support  in this section).
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Blackboard Collaborate Product Feedback
Blackboard Collaborate welcomes your comments and suggestions. If you have an idea for a new 
feature or enhancement, or would like to send other feedback, please send an email to 
BBCollaborateFeedback@blackboard.com.

Your feedback will be sent directly to our Product Management Team.
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Getting Started
Before you begin using the accessibility features of Blackboard Collaborate web conferencing, we 
recommend you do the following:

 l Ensure your system meets the necessary requirements (see System Requirements below).

 l Get Blackboard Collaborate ready to use accessibility features (see Getting Ready for a 
Blackboard Collaborate Session on page 7).

 l Read the parts of  this guide that are most relevant to you (see Using this Guide on page 7).

 l Familiarize yourself with the Blackboard Collaborate user interface (see The Blackboard 
Collaborate Web Conferencing Room on page 11).

System Requirements
In order to use the accessibility features in Blackboard Collaborate web conferencing, you must 
meet the following system requirements. 

Note: You can find the accessibility system requirements for all recent 
versions web conferencing via the Knowledge Base article System 
Requirements For Blackboard Collaborate Web Conferencing Accessibility 
Features.

http://support.blackboardcollaborate.com/ics/support/default.asp?deptID=8336&task=knowledge&questionID=2367
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Blackboard Collaborate Web Conferencing 
The full set of accessibility features are available only in the English version of Blackboard 
Collaborate. 

Operating System
Only Windows operating systems support all of the Blackboard Collaborate accessibility 
features:

 l Windows XP (32 bit), Windows Vista (32 bit or 64 bit), Windows 7 (32 bit or 64 bit) or 
Windows 8 (64 bit) 

 l 20 MB free disk space

 l 256 MB RAM 

Linux (Ubuntu 11.10 or higher) and Mac (Mac OS X 10.6 or higher) users can use only some of 
the Blackboard Collaborate accessibility features (e.g., keyboard navigation). There is no screen 
reader capability on these systems.

Note: Accessibility features are not officially supported on Linux and Mac 
systems.

Java 
Java 7, update 6, or higher  (32-bit or 64-bit) is required to run Blackboard Collaborate and the 
Java Access Bridge (see below). 

To check to see if you have the correct version of Java, open the following web page:

http://support.blackboardcollaborate.com/ics/support/default.asp?deptID=8336&task=knowledge&questionID=1473

The “Step 1- Checking System Requirements” will tell you whether or not you have the required 
version of Java Web Start and, if not, provide a link to the Java download page.

Screen Readers
JAWS (version 13 or 14) is the only supported screen reader for Blackboard Collaborate. 

Note: JAWS 13 and 14 support both 32-bit and 64-bit OSs/JVMs. 
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Java Access Bridge

The Java™ Access Bridge is a technology that enables assistive technologies (such as screen 
readers, magnifiers, etc.) to access Java applications and applets. Because it comes bundled with 
Java 7 (update 6), there is no need to install it.

In order to use Blackboard Collaborate web conferencing version 12.6 or higher with the JAWS 
screen reader, you must enable Java Access Bridge version 2.0.3 or higher. For instructions , 
please see Knowledge Base article 2868. 

Getting Ready for a Blackboard Collaborate Session
If you will be using JAWS to navigate through the Blackboard Collaborate web conferencing 
interface, be sure to do the following:

 1. Start JAWS before you log in to the session. 

 2. Verify that the Java Access Bridge is working.

 3. Configure JAWS to read all access keys so the mnemonic keys are spoken aloud; other-
wise, you won’t be able to identify them. This setting is found under the basic settings of 
JAWS. 

It is advisable to enter the room early (before the session starts) so you can configure your 
Blackboard Collaborate interface to suit your particular needs. How early you can enter the 
room is set by the session creator. The default is 30 minutes but the session creator may change 
that.

 1. For those using audio in your Blackboard Collaborate session, run the Audio Setup Wizard 
to ensure your microphone and speakers are set to suitable levels. For details, see Using 
the Audio Setup Wizard on page 57.

 2. For all users, set which Audible and Visual Notifications you wish to receive in the session. 
For details, see Setting Notification Preferences on page 61.

Using this Guide
Blackboard Collaborate web conferencing has been designed to meet the needs of users of 
various abilities. Some of the accessibility features are helpful to those whose mobility make it 
difficult for them to use a mouse, others are for users who are deaf or hard of hearing and 
others are for users with limited vision (including color blindness) or no vision.

The following table lists the various target audiences and the accessibility features from which 
each would benefit, including a reference to the relevant section in this document. 
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User Issue Accessibility Features

Low Vision Maximizing window and panel sizes: refer to Managing Panels 
and Windows on page 15

Activity Window: refer to The Activity Window on page 37

Audible Notifications: refer to Audible Notifications on page 61

Keyboard Shortcuts: refer to Keyboard Shortcuts on page 27

Hot Keys: refer to Hot Keys on page 32

Keyboard Navigation: refer to Keyboard Navigation on page 20

Chat text size options: refer to Changing the Chat Text Size on 
page 68

Notes text size options: refer to Changing the Notes Text Size on 
page 70

Application Sharing hosting option Emphasize cursor: refer to 
Hosting Options on page 66

Application Sharing viewing features to scale the shared content 
and maximize the content area: refer to Application Sharing 
Options on page 65

Blind Activity Window: refer to The Activity Window on page 37

Audible Notifications: refer to Setting Notification Preferences on 
page 61

Keyboard Shortcuts: refer to     Keyboard Shortcuts on page 27

Hot Keys: refer to Hot Keys on page 32 

Keyboard Navigation: refer to Keyboard Navigation on page 20

Deaf or Hard of 
Hearing

Activity Window: refer to The Activity Window on page 37

Visual Notifications: refer to Setting Notification Preferences on 
page 61

Closed-Captioning: refer to Closed-Captioning on page 49

Audio volume controls: refer to Adjusting Microphone and 
Speaker Levels on page 60

Audio Setup Wizard: refer to Using the Audio Setup Wizard on 
page 57
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User Issue Accessibility Features

Mobility Keyboard Shortcuts: refer to Keyboard Shortcuts on page 27

Hot Keys: refer to Hot Keys on page 32

Mnemonic Keys: refer to Mnemonics on page 26

Keyboard Navigation: refer to Keyboard Navigation on page 20

Color Blind Closed-Captioning window display options: refer to Window 
Display Options on page 53

Application Sharing hosting options Shared Region Highlight 
Color and Emphasize cursor: refer to Hosting Options on page 66
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The Blackboard Collaborate Web 
Conferencing Room

The Blackboard Collaborate web conferencing room consists of six main components: the menu 
bar at the top, three panels on the left (Audio & Video panel on top, the Participants panel in the 
middle and Chat panel on the bottom), the Collaboration toolbar at the top of the right side and 
the main content area on the right (for displaying Whiteboard, Application Sharing and Web 
Tour content). 

Note: For mobile device users, the Web Conferencing room will not be 
exactly as described in this chapter. For a discussion of attending sessions 
on mobile devices, refer to the Mobile User's Guide for your device (iOS or 
Android) on the On-Demand Learning Center: 
http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-
Learning-Center/Web-Conferencing.aspx#documentation 

http://www.blackboard.com/docs/documentation.htm?DocID=611027PDF
http://www.blackboard.com/docs/documentation.htm?DocID=611027PDF
http://www.blackboard.com/docs/documentation.htm?DocID=611027PDF
http://www.blackboard.com/docs/documentation.htm?DocID=611027PDF
http://www.blackboard.com/docs/documentation.htm?DocID=611027PDF


Term Meaning

Menu bar The Menu bar contains the File, Edit, View, Tools, Windows and 
Help menus.

Audio & Video panel The Audio & Video panel  enables you to participate in conversations 
using either a microphone and speakers (or headset) or via a tel-
econference. You also can transmit and receive Video during the ses-
sion and preview your video before transmitting it.

Participants panel The Participants panel provides a list of all Participants and Mod-
erators in the session and information about their current activities, 
such as talking (Audio), transmitting Video, sending a Chat message, 
using the Whiteboard drawing tools  and conducting an Application 
Sharing session. Above the Participants list is a small toolbar con-
taining buttons for raising your hand and stepping away from the 
session and menus for selecting polling responses and feedback 
options.

Chat panel The Chat panel enables you to send Chat messages  to everyone in 
the room or to Moderators only. By selecting names in the Par-
ticipants list, you can send private Chat messages to individuals. Mes-
sages can be printed and saved to track session communication.

Collaboration toolbar The Collaboration toolbar (at the top of the Content area) contains 
three buttons for switching between the three content modes 
(Whiteboard, Application Sharing and Web Tour) in the Content 
area; an Information menu for obtaining session information (e.g., 
connection type) and starting the Timer; a Load Content button for 
loading content into the session; and the Record button.

Content area The Content area is the main presentation window. Moderators use 
this region to load presentations. Everyone can use the tools on the 
Whiteboard to draw or write. All the objects and images on the 
Whiteboard are dynamic and can be modified. Everyone can print 
the Whiteboard pages or save them to a file to review later (unless 
the Whiteboard has been protected).
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1 Title bar 6 Minimize button

2 Menu bar 7 Maximize button

3 Audio & Video panel 8 Close button

4 Participants panel 9 Collaboration toolbar

5 Chat panel 10 Content area

The Content Area Modes
The content area on the right side of your Blackboard Collaborate web conferencing interface, 
enables you to exchange information and ideas with others through three different features: 

 n the Whiteboard, for sharing presentations and drawings;

 n Application Sharing, for sharing individual applications or your entire desktop; and

 n Web Tour, for sharing web pages.
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These features share  space in the content area, with each representing a "mode" in the content 
area, so you will be able to see the content of only one mode at a time. The Whiteboard content 
is persistent so will be there when you move to another mode and then return to the 
Whiteboard. Application Sharing content is persistent but you need to Resume Sharing when 
you return to Application Sharing in order to see it. Web Tour content will always have to be 
reloaded (URL entered again) when you switch modes and return to Web Tour. 

Only certain users can switch between modes:

 n Moderators  can switch between all modes. 

 n Participants with Application Sharing permission can switch to Application Sharing mode 
and back to Whiteboard mode.

 n Participants with Web Tour permission can switch to Web Tour mode and back to White-
board mode.

Note: Participants who have Whiteboard permission  but not Application 
Sharing or Web Tour permission are not able to switch to Whiteboard 
mode from either of the other two modes. This safeguards against 
Participants switching modes during someone else's Web Tour or 
Application Sharing presentation.  

When someone switches modes, everyone in the session will follow them to the new mode.

Caution: Be careful not to inadvertently switch modes on someone else 
who is presenting content. Everyone in the session will follow you to the 
new mode.

To switch modes, do one of the following:

 o Click on the button in the Collaboration toolbar associated with the desired mode. 

 o Select the desired mode from the View menu.

 o Use the keyboard shortcut associated with the desired mode:

Whiteboard mode: Ctrl+Alt+W (Command-Option-W on Mac)

Application Sharing mode: Ctrl+Alt+A (Command-Option-S on Mac)

Web Tour mode: Ctrl+Alt+U (Command-Option-U on Mac)
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You can easily see which mode is selected by noting which  button in the Collaboration toolbar is 
colored. In the Collaboration toolbar below, the current mode is Whiteboard mode.

1 Whiteboard mode button 3 Web Tour mode button

2 Application Sharing mode button   

Managing Panels and Windows
The Blackboard Collaborate web conferencing interface consists of panels and windows. Panels 
can be collapsed, expanded, detached and reattached, resized and, in their detached state, can be 
moved.  The side panels (Audio & Video, Participants and Chat) also can be hidden.    For details, 
see Working with Panels on page 17.

The main application window can be minimized, maximized, moved, resized and closed. Other  
windows can be opened, moved, resized and closed. For details, see Working with Windows 
below.

Working with Windows
There are a number of different kinds of windows in Blackboard Collaborate web conferencing: 
the main application window, module windows (such as the Notes window and the Multimedia 
Library), dialog boxes (such as the Preferences dialog and Create Breakout Rooms dialog) and 
utility windows (such as the Object Explorer and Page Explorer). 

Below are the ways you can manage  your windows: 

 n Open the main application window: To open the window you need to join the ses-
sion by clicking on a link. 
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 n Open  a main module window: To open the window of one of the main modules, 
select it from the Window menu or, if available, open it using its associated keyboard 
shortcut (see Keyboard Shortcuts on page 27.)

 n Move a window: Grab the window by its title bar and, while holding down your mouse, 
drag it to the desired location and then drop it by releasing the mouse.

 n To resize a window: Grab a window border and drag it. Hold your mouse over any side 
or a corner and, when the cursor changes to a two-headed arrow, click and drag the 
border of the window to contract or expand it. 

 n Minimize or maximize the main application window: Use the standard 
conventions of your operating system for minimizing and maximizing windows. For 
example, on Windows, use the Minimize and Maximize buttons in the window's title bar:

 n Un-obscure a window:  If part of a window is obscured by another window or panel,  
click on the window itself to bring it to the front of the other window or panel. 

Tip: If you can't find a window because it is hidden beneath other 
windows, an easy way to find it is to select Restore Default Layout 
from the View menu and then open your window again.
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 n Close a main module window: To close a main module window, do one of the fol-
lowing:

 o Click on the window’s Close button in the title bar of the window.

 o Enter Ctrl+W (Command-W on Mac) 

 o Enter Alt+F4 (Windows and Linux only)

 n Close the main application window: If you close the main application window you 
will leave the session. For details, see the Moderator's Guide.

Working with Panels
The default when you first join a Blackboard Collaborate web conferencing session is for the 
Participants and Chat panels to be expanded and attached and the Audio & Video panel to be 
collapsed and attached. Blackboard Collaborate will remember the state in which you left your 
panels (expanded or collapsed and attached or detached) from one session to the next (but only 
if you are logged in to the same computer).

Below are the ways you can manage  your panels:

 n Collapse and expand a panel: By default, the panels are expanded. If you want to 
make more room for one of the panels, you can collapse the others. 

To collapse a panel, click on the Collapse button in the panel's title bar:

To expand the panel back to its former state, click on the Expand button in the panel's 
title bar:

 n Move a panel: Grab the panel (either attached or detached) by its title bar and, while 
holding down your mouse, drag it to the desired location and then drop it by releasing the 
mouse.
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 n Detach and reattach a panel: Panels can be detached so you can move them to a 
more convenient location.

To detach a panel, do one of the following: 

 o From the Options menu, select Detach Panel.

 o Drag and drop the panel out of the main application window. (See Move a panel 
above.)

To reattach a panel, do one of the following: 

 o From the Options menu, select Attach Panel.

 o Drag and drop the panel back into the main application window. (See Move a 
panel above.)

 o From the View menu, select Restore Default Layout.

 o Click on the panel's Close button:

 n Reorder an attached panel: Drag and drop the panel up or down within the side bar 
area (left side) of the main application window. (See Move a panel above.)

 n Hide attached side panels: You can make the Content area larger by hiding the side 
bar area (left side) of the main application window. To do so, in the View menu, unselect 
(uncheck) Show Side Bar. To restrore the side bar, reselect it. Alternatively, you can grab 
the border of any one of the panels and drag it all the way to the left. To bring the side bar 
back, grab it again and move to the right.

 n Resize a panel: Grab a panel border and drag it. Hold your mouse over any side (either 
attached or detached) or a corner (detached only) and, when the cursor changes to a two-
headed arrow, click and drag the border of the panel to contract or expand it. 

 n Un-obscure detached panels: If part of the panel is obscured by another panel or win-
dow,  click anywhere on the panel to bring it to the front of the other panel or window.
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Navigation
Before using Blackboard Collaborate web conferencing, it may be useful to familiarize yourself 
with the user interface. See The Blackboard Collaborate Web Conferencing Room on page 11 
for a description of the main user interface components.

There are three ways to navigate through the Blackboard Collaborate user interface without 
having to use a mouse:

 l Keyboard navigation – see Keyboard Navigation on next page

 l Mnemonics – see Mnemonics on page 26

 l Shortcut keys – see Keyboard Shortcuts on page 27

For information about navigating within some specific areas, refer to the following: 

 l Navigating Between and Within Content Modes on page 22

 l Navigating Between and Reading Whiteboard Pages on page 24

 l Navigating Between Chat Conversation Tabs on page 25



Keyboard Navigation
There are four levels of keyboard navigation in Blackboard Collaborate web conferencing:

 n between modules in the main application window 

 n between elements (both within and across modules)

 n within toolbars of a secondary window

 n within  menus

Using the navigation methods described in the following sections, navigate to the desired 
function to bring it into focus. When you wish to activate that function (execute the command), 
press Space. 

Navigating Between Modules
When you join an Blackboard Collaborate session, the Participants panel is in focus. Press F6 
(the same on the Mac) to cycle keyboard focus between the main Blackboard Collaborate 
modules, in the order listed below: 

 l Participants panel: focus goes to the top name in the Participants list. 

 l Chat panel: focus  goes to the Message text box.

 l Collaboration toolbar: focus  goes to the Whiteboard mode button.

 l Action bar: focus  goes to the New Page button.

 l Audio & Video panel: focus goes to the Talk button.

 Note: If you change the order of the panels, the F6 navigation order will 
be different. For information on reordering the panels, see Working with 
Panels on page 17.

Navigating Between Elements
You can navigate through the Blackboard Collaborate user interface one element (e.g., button, 
field, option, etc.) at a time by tabbing. The Tab key moves you forward through the Blackboard 
Collaborate elements in the sequence described below. To move backwards in the sequence, 
enter Shift+Tab.

 Note: Within each panel or window, tabbing moves through its elements 
from left to right and top to bottom.
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Your tabbing sequence may differ from that described below since the elements you see in the 
user interface depends on your permissions, including whether or not you are a Moderator or 
Participant.

 n Participants List – When you join a Blackboard Collaborate session, focus will be on 
the top name in the Participants list. Within the list you can move through the names 
using the up and down arrow keys. Press Space to open the Participant Options menu for 
the person currently in focus.

 n Chat Panel –Next you will tab through the elements in the Chat panel: Expand/Collapse 
button, Options menu, Conversation pane, Message text box and Conversation tabs. (For 
instructions on moving between Conversation tabs, see Navigating Between Chat Con-
versation Tabs on page 25.)

 n Collaboration Toolbar – Next you will tab through the elements in the Collaboration 
toolbar: Whiteboard Mode button, Application Sharing Mode button, Web Tour Mode but-
ton, Timer elements (if the Timer is running), Information menu, Load Content button 
and Record button.  (For instructions on changing modes, see Navigating Between and 
Within Content Modes on next page.)

 n Action Bar – Next you will tab through the elements in the Action bar for the currently 
selected mode or, the Available Share Selection dialog for Application Sharing Mode.

 n Audio & Video Panel – Next you will tab through the elements in the Audio and Video 
panel: Expand/Collapse button, Audio Setup Wizard button, Options menu, Microphone 
Level slider, Speaker Level slider, Talk button, Transmit Video button and Preview Video 
button.

 n Participants Panel – Next you will tab through the elements in the Participants panel: 
Expand/Collapse button, Global Options menu, Feedback menu, Step Away button, Raise 
Hand button, Polling Response menu and then, finally, back to the Participants list.

Navigating Within a Toolbar of a Module Window
When you open a module's window, you can use tabbing to navigate through the various 
elements of its interface, with one exception: toolbar buttons. The Closed Captioning, File 
Transfer Library and Notes windows have graphic tool bars with buttons represented by icons. 
You must explicitly enable tabbing to access these buttons. 

To do so, enter Alt+F8 (Option-F8 on the Mac). To turn toolbar tabbing off, enter Alt+F8 
(Option-F8 on the Mac) again.
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Navigating Within Drop-Down Menus
To open an Options menu, Participant interaction menu (Feedback and Polling Response 
menus) or other drop-down menu, tab to it and press Space. Using up and down arrow keys, 
move to the desired menu option and press Space to activate it. If the menu option is a sub-
menu, press  Space or the right arrow key to open it. 

To close the menu without selecting a menu option, press Escape.

Tip: To access the main menus (e.g., File, Edit, etc.) use mnemonic keys. 
(See Mnemonics on page 26.) You cannot use tabbing to open these 
menus; however, once a menu is open, you can use your arrow keys to 
navigate within it and Space to execute the menu item command. 

Navigating Between and Within Content Modes
When you open a new session, the Whiteboard is your default content mode. You can use 
keyboard navigation or keyboard shortcuts to move between  content modes and keyboard 
navigation to move within content modes. 

Note: To switch to a content mode, you must be a Moderator or a 
Participant with permission to use that mode.

Navigation within each content mode is unique, as described below. 

Navigating within Whiteboard Content Mode
Follow the steps below to switch to Whiteboard mode and access the functions in the Action 
bar:

Note: If you are a Participant or a Moderator without the Whiteboard 
permission, F6 navigation will place focus  on the Scaling menu of the 
Whiteboard Action bar. 

 1. To switch to Whiteboard mode, do one of the following: 

 o Keyboard Shortcut
Enter Control+Alt+W (Command-Option-W on Mac)

 o Keyboard Navigation
Press F6 (the same on the Mac) to cycle keyboard focus to the Collaboration tool-
bar. By default, you will be in Whiteboard Mode.

 2. Press F6 again to move to the Whiteboard Action bar.
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 3. Use Tab, Shift+Tab and the  arrow keys to move between the elements in the Action bar 
and the adjacent Navigation bar.

 4. Press Space to activate the selected function. 

Navigating within Application Sharing Mode
Follow the steps below to switch to Application Sharing mode and start hosting an Application 
Sharing session:

Note: If someone else is already hosting an Application Sharing session 
(you are already in Application Sharing mode), F6 navigation will place 
focus  on the Scale to Fit option of the Application Sharing Action bar. 

 1. To switch to Application Sharing mode, do one of the following:

 o Keyboard Shortcut
Enter Control+Alt+A (Command-Option-A on Mac)

 o Keyboard Navigation

 i. Press F6 (the same on the Mac) to cycle keyboard focus to the Collaboration 
toolbar. By default, you will be in Whiteboard Mode.

 ii. Press Tab or Right Arrow once to move to the Application Sharing Mode 
button.

 iii. Press Space to activate Application Sharing Mode. The Application Sharing 
Selections dialog will open.

 2. Press Tab five times to move through the elements in the Collaboration toolbar to the 
Share Desktop (the first) field of the Application Sharing Selections dialog.

 3. You have two options: 

 o Share your entire desktop: Press any of the arrow keys to select Share Desk-
top, press Tab three times to move to the Share button and press Space to start 
sharing your desktop.

 o Share a specific application only: Press Tab to move to the list of available 
applications and then, using the arrow keys, select the desired application from the 
list. Press Tab twice to move to the Share button and press Space to start sharing 
the selected application.
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Navigating within Web Tour Mode
Follow the steps below to switch to Web Tour mode and start hosting a Web Tour:

Note: If someone else is already hosting a Web Tour session (you are 
already in Web Tour mode) and you don't have Web Tour permission, F6 
navigation will place focus  on the Back button of the Web Tour Action 
bar. 

 1. To switch to Web Tour mode, do one of the following: 

 o Keyboard Shortcut
Enter Control+Alt+U (Command-Option-U on Mac)

 o Keyboard Navigation

 i. Press F6 (the same on the Mac) to cycle keyboard focus to the Collaboration 
toolbar. By default, you will be in Whiteboard Mode.

 ii. Press Tab or Right Arrow  twice to move to the Web Tour Mode button.

 iii. Press Space to activate Web Tour  Mode. The Web Tour Action bar will open 
and focus will be in the Address text box.

 2. Use Tab, Shift+Tab and the  arrow keys to move between the elements in the Action 
bar.

 3. Press Space to activate the selected function or, if in the Address text box, open the spec-
ified web page. 

Navigating Between and Reading Whiteboard Pages
If you are using a JAWS screen reader, you can read the text of presentations imported into the 
Whiteboard via the Activity Window. Navigate to the desired page (as instructed below) and open 
the Activity Window using Control + / (Command- / on Mac) to read the textual content of that 
page. You will need to move focus to the bottom of the window. (For details on using the 
Activity Window, see The Activity Window on page 37.)

Note: You can freely navigate between pages in breakout rooms but must 
be given permission by the Moderator to navigate between pages of the 
Main room. You will know you are free to move between Main room 
pages when you see a red border around your Whiteboard content area. 

To move directly to a specific Whiteboard page, select it from the Go to Page menu in the 
Whiteboard navigation bar. For instructions on keyboard navigation to that menu, see 
Navigating within Whiteboard Content Mode on page 22.
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Tip:  If using a screen reader, you’ll know you are in the Go to Page menu 
when you hear, “Go to the selected Whiteboard page.” 

To move to the next page, use any of the following methods: 

 o Keyboard Shortcut
Enter Alt+Page Down (Option-Page Down on Mac).

 o Mnemonic Keys
Using mnemonics keys, from the Tools menu select Whiteboard followed by Go to Next 
Page. (For instructions on using mnemonic keys, see Mnemonics on next page.)

 o Keyboard Navigation
Navigate to and activate the Next Page button in the Whiteboard Navigation bar.
If focus is on the Go to Page menu of the Navigation bar, press the Down Arrow.
(For instructions on keyboard navigation in Whiteboard Mode, Navigating within White-
board Content Mode on page 22.)

To move to the previous page,  use any of the following methods: 

 o Keyboard Shortcut
Enter Alt+Page Up (Option-Page Up on Mac).

 o Mnemonic Keys
Using mnemonics keys, from the Tools menu select Whiteboard followed by Go to 
Previous Page. (For instructions on using mnemonic keys, see Mnemonics on next page.)

 o Keyboard Navigation
Navigate to and activate the Previous Page button in the Whiteboard Navigation bar.
If focus is on the Go to Page menu of the Navigation bar, press the Up Arrow.
(For instructions on keyboard navigation in Whiteboard Mode, Navigating within 
Whiteboard Content Mode on page 22.)

Navigating Between Chat Conversation Tabs
You can use keyboard navigation to move between the private Chat conversation tabs in the 
Chat panel. 

Tip: If you want to know when a new private Chat message has been 
received, enable the Audible Notification "Private Chat Message Received". 
For details, see Audible Notifications on page 61.
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 1. Press F6 (the same on the Mac) to cycle keyboard focus to the Chat panel. 

 2. Press Tab twice to move to the currently open conversation tab. (By default, this is the 
Room conversation.)

 3. Use  the arrow keys to move to the desired conversation tab. 

 4. Press Space to open the conversation.

If there are too many conversation tabs to fit in the Chat panel, they will be added to a drop-
down menu to the right of the displayed conversation tabs. To open a conversation tab in the 
menu, do the following:

 1. From your currently open conversation tab, press Tab. This will move focus to the 
conversation drop-down menu.

Note: if there is no conversation drop-down menu, focus will move 
to the Collaboration toolbar.

 2. Press Space to open the menu.

 3. Use  the arrow keys to move to the desired conversation.

 4. Press Space to open the conversation.

Using Mnemonic and Keyboard Shortcuts
Instead of using your mouse to select a menu option, you can use your keyboard. Using 
mnemonic or Keyboard Shortcuts saves time because you do not have to complete multiple steps 
(e.g., clicking on a menu and then clicking on an option), nor do you have to take your hand off 
the keyboard to issue the command. 

Note: Mnemonic and standard Keyboard Shortcuts are enabled only 
when you have input focus on the Blackboard Collaborate web 
conferencing window. Focus is not required for Hot Keys.

Mnemonics
A mnemonic is an underlined letter or number that appears in a menu title or menu option that, 
when pressed in conjunction with the ALT key, activates a command or navigates to an element 
in the user interface.

Mac Note: Keyboard mnemonics are not supported on the Mac.
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Note: On Windows, depending upon your configuration, you may have to 
toggle ALT  the  key before the options in the menus will display the 
underlined character or number. 

To choose a menu option with mnemonics, do the following:

 1. Press the ALT  key, note which letter or number (mnemonic) is underlined in the desired 
menu name and enter it on your keyboard. The menu options for that main menu will 
appear. For example, if you press ALT+F, the File menu will appear.

 2. Again, note the mnemonic for the desired option in the menu and enter it, with or with-
out the  ALT key.

To select a menu option from a sub-menu, repeat step 2. 

Keyboard Shortcuts
You can quickly accomplish tasks you perform frequently by using keyboard shortcuts (both 
standard keyboard shortcuts and hot keys). Keyboard shortcuts are one or more keys you press 
in combination to perform a function within Blackboard Collaborate web conferencing. For 
example, instead of clicking the Raise Hand button  in the Participants panel or selecting Raise 
Hand from the Interaction menu, you can press Ctrl+R (Command-R on Mac OS X) to raise 
your hand. 

Hot keys differ from standard keyboard shortcuts in some important ways. For details, and a 
discussion of hot keys, see Hot Keys on page 32.

Note: The keyboard shortcuts were defined with an extended (full) 
keyboard layout in mind. If your keyboard does not have a key used in a 
keyboard shortcut, you will need to use the menu item or toolbar button 
to perform the desired function. 

Caution: If you are sharing an application that has a keyboard shortcut 
identical to one in Blackboard Collaborate, and focus is on Application 
Sharing, the shortcut will activate its associated command in the shared 
application, not in Blackboard Collaborate. 

The following table lists the keyboard shortcuts (both standard and hot keys) present in 
Blackboard Collaborate to quickly perform a number of common functions.The first column 
describes the function to be performed, the second column lists the Windows and Linux 
keyboard shortcuts and the third column gives the Mac keyboard shortcuts. Keys are grouped 
into sections based on the Blackboard Collaborate module being used. 

Note: To access the list of keyboard shortcuts while in a session, select 
Keyboard Shortcuts from the Help menu. 
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Function Windows, etc. keys Mac keys

Application, Window and File Functions

Quit Blackboard Collaborate Alt+F4 

Ctrl+Q

Command-Q

Hide Blackboard Collaborate N/A Command-H

Hide other applications N/A Option-Command-H

Close window (Notes, Activity, Closed-
Captioning, Calculator) 

Alt+F4

Ctrl+W

Command-W

Switch to Whiteboard Mode Ctrl+Alt+W Command-Option-W

Switch to Application Sharing Mode Ctrl+Alt+A Command-Option-A

Switch to Web Tour Mode Ctrl+Alt+U Command-Option-U

Open Preferences dialog box Ctrl+Comma Command-Comma 

Save Participants list, Chat conversation or 
Whiteboard

Ctrl+S Command-S

Print Participants list or Whiteboard Ctrl+P Command-P

Keyboard Navigation Functions

Move to the next main module in the user 
interface. The default order is Participants 
panel, Chat panel, Collaboration toolbar, 
Action bar and Audio& Video panel. (If you 
change the order of the panels, the order 
will change.) 

F6 F6

Open the Action bars of Whiteboard Mode 
and Web Tour mode

F6 F6

Move to the previous main module in the 
user interface. (See F6 above for the order 
of modules.)

Shift+F6 Shift-F6
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Function Windows, etc. keys Mac keys

Move to the next user interface element 
(e.g., button, field, option) in  a main 
module or UI element. For example, if 
focus is in the Collaboration toolbar, Tab 
and Shift-Tab can be used to move between 
the three modes (Whiteboard, Application 
Sharing and Web Tour), the Information 
menu, the Load Content button and the 
Record button. 

Tab Tab 

Move to the previous user interface 
element (e.g., button, field, option) in a 
main module (see example for Tab above)

Shift+Tab Shift-Tab

Activate the currently selected function Space Space

Enable tabbing in toolbars of secondary 
windows (Closed Captioning, Notes, Activity 
Window, File Transfer)

Alt+F8 Option-F8

Move keyboard focus between open 
windows (Notes, File Transfer, Activity, 
Closed-Captioning, Calculator) 

Alt+F6
(Windows XP and Linux 
only) 

Command-`

Open Options menu of the panel or toolbar 
in focus (Audio & Video, Chat, Participants, 
Whiteboard action bar, Whiteboard 
navigation bar or Web Tour)

Ctrl+Shift+O Command-Shift-O

Activity Window Functions

Open Activity Window Ctrl+/ Command-/

Close Activity Window Ctrl+/

Alt+F4

Ctrl+W

Command-W

Audio Functions

Press the Talk button

(Note: this is a Hot Key ─ see Hot Keys on 
page 32.) 

Ctrl+F2 Control-F2

Release the Talk button

(Note: this is a Hot Key ─ see Hot Keys on 
page 32.) 

Ctrl+F2 Control-F2
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Function Windows, etc. keys Mac keys

Adjust microphone level down Ctrl+Shift+Down Arrow Command-Shift-
Down Arrow

Adjust microphone level up Ctrl+Shift+Up Arrow Command-Shift-Up 
Arrow 

Adjust speaker level down Ctrl+Alt+Down Arrow Command-Option-
Down Arrow 

Adjust speaker level up Ctrl+Alt+Up Arrow Command-Option-Up 
Arrow 

Video Functions

Start Video transmission
(Note: this is a Hot Key ─ see Hot Keys on 
page 32.) 

Ctrl+F3 Control-F3

Stop Video transmission
(Note: this is a Hot Key ─ see Hot Keys on 
page 32.) 

Ctrl+F3 Control-F3

Whiteboard Functions 

Select all objects in Whiteboard Ctrl+A Command-A

Open Page Explorer window Ctrl+Shift+P Command-Shift-P

Open Object Explorer window Ctrl+Shift+T Command-Shift-T

Copy selected object(s) or text in 
Whiteboard

Ctrl+C Command-C

Cut selected object(s) or text in Whiteboard Ctrl+X Command-X

Paste copied or cut object(s) or text to 
Whiteboard

Ctrl+V Command-V

Group selected objects Ctrl+G Command-G

Ungroup selected objects Ctrl+U Command-U

Delete selected object(s) or text in 
Whiteboard

Delete

Backspace

Delete

Backspace

Go to next page Alt+Page Down Option-Page Down

Go to previous page Alt+Page Up Option-Page Up

Move to first page at this topic level Alt+Home Option-Home
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Function Windows, etc. keys Mac keys

Move to last page at this topic level Alt+End Option-End

Application Sharing Functions

Take back control of Application Sharing
(Note: this is a Hot Key ─ see Hot Keys on 
next page.) 

Ctrl+Space Control-Space

Stop Application Sharing 
(Note: this is a Hot Key ─ see Hot Keys on 
next page.) 

Ctrl+Shift+S Control-Shift-S

Chat Functions

Move cursor to the Message text box of the 
Chat panel 

Ctrl+M Command-M

Select all Chat text in conversation pane Ctrl+A Command-A

Copy selected Chat text in conversation 
pane

Ctrl+C Command-C

Paste copied Chat text to Chat Message text 
box, Whiteboard or external application

Ctrl+V Command-V

Participant Panel Functions

Raise or lower your hand Ctrl+R Command-R

Show that you have stepped away or come 
back

Ctrl+Shift+A Command-Shift-A

Show smiley face Alt+1 Option-1

Show LOL Alt+2 Option-2

Show applause Alt+3 Option-3

Show confusion Alt+4 Option-4

Show approval Alt+5 Option-5

Show disapproval Alt+6 Option-6

Show Slower (when you want the presenter 
to slow down)

Alt+7 Option-7

Show Faster (when you want the presenter 
to speed up)

Alt+8 Option-8

Show None (when you want to clear all 
displayed emoticons)

Alt+0 Option-0
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Function Windows, etc. keys Mac keys

Notes Functions

Open Notes window Ctrl+E Command-E

Close Notes window Alt+F4

Ctrl+W

Command-W

Closed-Captioning Functions

Open Closed-Captioning window Ctrl+F8 Command-F8

Close Closed-Captioning window Alt+F4

Ctrl+W

Command-W

Polling Functions

Yes - polling response Ctrl+1 Command-1

No - polling response Ctrl+2 Command-2

A - polling response Ctrl+1 Command-1

B - polling response Ctrl+2 Command-2

C - polling response Ctrl+3 Command-3

D - polling response Ctrl+4 Command-4

E - polling response Ctrl+5 Command-5

None Ctrl+0 Command-0

 

Hot Keys

Hot keys are a type of keyboard shortcut but differ from standard keyboard shortcuts two ways: 

 n You can modify the definition of these keys.

 n You do not need to have input focus on the Blackboard Collaborate web conferencing win-
dow to use them (they are available system-wide).

By default, seven hot keys have been defined for the commonly used features in Blackboard 
Collaborate. You can use these default hot keys (listed in the following table) or define your own 
in the Preferences dialog. For instructions, see Configuring Hot Keys on the facing page.

Linux Note: Num Lock and Caps Lock must be turned off for Hot Keys 
to work in a Blackboard Collaborate session running on Linux. 
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The default values for the two Talk hot keys are the same and the default values for the two 
Video hot keys are the same. If you keep the default values for the Talk keys, you can use 
Ctrl+F2 (Control-F2 on Mac) to toggle the Talk button on and off. If you keep the default values 
for the Video keys, you can use Ctrl+F3 (Control-F3 on Mac) to start and stop Video.

Tip for Screen Reader Users: With toggle commands, it is not always 
easy to remember which state you are currently in. You can always be sure 
that you are sending the desired command by redefining one of the hot 
keys in each toggle pair. For example, if you keep the default for pressing 
the Talk button Ctrl+F2 (Control-F2 on the Mac) and redefine the hot key 
for releasing the Talk button to something else, Ctrl+F2 (Control-F2 on 
the Mac) will always turn on the Talk button and your redefined hot key 
will always turn off the Talk button -- you will never have to know 
whether or the Talk button it is currently turned on or off.

The default hot keys are listed in the following table where the first column describes the 
function to be performed, the second column lists the Windows and Linux  hot key and the third 
column gives the Mac hot key. 

Function Windows & Linux Key Mac Key

Press the Talk button Ctrl+F2 Control-F2

Release the Talk button Ctrl+F2 Control-F2

Take back control of Application Sharing Ctrl+Space Control-Space

Stop Application Sharing Ctrl+Shift+S Control-Shift+S

Start Video transmission Ctrl+F3 Control-F3

Stop Video transmission Ctrl+F3 Control-F3

 

Configuring Hot Keys

Exercise caution when changing the default definitions of hot keys. Ensure you do not change a 
hot key definition to that of a hot key used by another application. You also should avoid key 
combinations that conflict with standard keyboard shortcut operations. 

Note: On Windows and Linux, the hot key is restricted to one character. 
You may include one or more modifier keys (Shift, Control or ALT  on 
Windows). 

Mac Note: Mac OS X users must include at least one modifier key in the 
keystroke: ⇧Shift, ^ Control, ⌥  Option or ⌘ Command) .
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Configure your hot keys in the Preferences dialog.

 1. Open the Preferences dialog in one of the following ways:

 o From the Edit menu, select Preferences… (Windows & Linux) 

From the Blackboard Collaborate web conferencing menu, select Preferences 
(Mac OS X)

 o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

 2. In the left pane of the Preferences dialog, select Hot Keys under General. The Hot Keys 
preferences panel appears. 

Note: If you see an X under the Valid column, this indicates that 
the hot key is not available. It is likely being used by another open 
application. Either redefine the hot key to something valid or close 
the other application.
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 3. From the Hot key preferences panel, select the hot key you wish to revise and click 
Modify…. The Edit Hot Key dialog opens.

 4. Assign the keystrokes. Click on the down arrow to select a key from the key option list 
and then select the desired modifier keys by clicking on their check boxes. For example, 
the keystroke in the screen capture above is Ctrl+F2.

 5. Click on OK to save the hot key configuration and close the Edit Hot Key dialog, or 
Cancel to close the Edit Hot Key dialog without saving your changes.

 6. Click on OK to save your preferences and close the Preferences dialog, Apply to save 
your preferences and leave the Preferences dialog open or Cancel to close the Preference 
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate web conferencing will remember the 
settings each time you join another session on the same computer. 
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Chapter 4 

Page 37

The Activity Window
The Activity Window is an accessibility feature of Blackboard Collaborate web conferencing that 
can be useful to both hard of hearing/deaf and low vision/blind users. It is a stand-alone 
window that reports various events that take place in Blackboard Collaborate throughout the 
duration of a session. The window has a simple design so you can use a screen reader to navigate 
through the user interface and read the events as they occur. The Activity Window also enables 
you to perform simple functions through a command line interface. The window consists of the 
following main components: 



  

1 Show/Hide Command Input field

2 Audible Notification Filter

3 Module Event Filter

4 Importance Event Filter

5 Close button

6 Tool bar

7 Event panel

8 Command Input field

  

 

The Tool Bar, at the top of the window, contains the Show/Hide Command Input Field 
button, the Audible Notifications Filter, the Module Event Filter and the Importance Event 
Filter. (These are described a little later.)

The Event Panel, in the middle of the window, reports the events that have occurred in the 
session.

The Command Input Field, at the bottom of the window, enables you to type commands to 
perform some basic tasks in Blackboard Collaborate.

Opening and Closing the Activity Window
Opening and closing the Activity Window is simple so you can access it without your attention 
being diverted from the session in progress. If you move to a different window in Blackboard 
Collaborate web conferencing, you easily can bring the Activity Window back into focus (activate 
it). 

You also can move, resize or close the Activity Window so it is not obtrusive. 

Note: On Windows, Linux and Mac OS X platforms, the Activity Window 
always remains in front of the Blackboard Collaborate main window. On 
Solaris, if you click on the main Blackboard Collaborate window, the 
Activity Window will move behind the main window. 
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To open or activate (bring into focus) the Activity Window, do one of the following:

 o Enter the keyboard shortcut Control+/ (Command- / on Mac)

 o From the Window menu, select  Show Activity (on Windows or Linux, you can use the 
mnemonic Alt+W+A to select it)

To close the Activity Window, do one of the following:

 o Enter the keyboard shortcut  Control+W or   Alt+F4 (Command-W on Mac)

 o From the Window menu, select  Show Activity (on Windows or Linux, you can use the 
mnemonic Alt+W+A to select it)

 o Click on the Close button in the top-right corner of the window

Displaying Events
Notable events that occur in an Blackboard Collaborate web conferencing session are displayed 
in the Event panel of the Activity Window. By default, events of all Blackboard Collaborate 
modules are displayed and the approximate time each event occurred is noted. Moderators can 
see all events and Participants can see only a subset of events.

When a new event is reported, keyboard focus stays at the last place you had it (the last cursor 
position is maintained and the window will not scroll to the new message at the bottom). You 
need to manually move focus to the new event using your arrow keys or scroll bar so you can 
read the new text.

Note: The complete list of events is shown in the Event Filtering 
Preferences panel. (For details, refer to Event Filtering Preferences Panel 
on page 43.)

You can manage your display in three ways:

 l Filter which events are to be displayed in the event panel (see Filtering Events for Display 
on next page).

 l Change the text size in the event panel (see Resizing Activity Window Text on page 44).

 l Show or hide the time stamps associated with events (see Showing/Hiding Time Stamps 
on page 44).

Tip: Although there is no Save or Export function in the Activity 
Window, if you want to save a history of the activity, simply copy and 
paste the events into a text editor.         
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Filtering Events for Display
You can select which events you want displayed in your own Event panel through the Module 
Event Filter and the Importance Event Filter menus in the Activity Window or through the 
Event Filtering preferences panel. 

Note: The events you hide or display will affect what is displayed in your 
own Event panel only – it will not affect what others see in their own 
Event panels.

You can select which events for which you want to be audibly notified through the Audible 
Notifications Filter in the Activity Window or through the Audible Notifications Preferences 
panel. 

Audible Notifications Filter

Audible notifications are system messages sent by Blackboard Collaborate web conferencing to 
notify users when certain important events occur within the session. These notifications are 
presented as sounds. 

To open the Audible Notifications Filter menu, click on the 

Audible Notification Filter button in the tool bar. You 
can specify which set of audible notifications you would like 
to hear (all, basic or custom) from the Audible Notifications 
Filter. These are the same set of notifications you can 
configure in the Audible Notifications Preferences panel. See 
Audible Notifications on page 61 for details.

Custom Audible Notifications are the set of individual notifications that you selected in the 
Audible Notifications Preferences panel, rather than selecting All or Basic.

Note: The filtering options set in the Audible Notifications Filter are 
reflected in the Audible Notifications Preferences panel. Likewise, if you 
make a change to the options in the Audible Notifications Preferences 
panel, you will see these changes in the Audible Notifications Filter as 
well.
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Module Event Filter

The Module Event Filter is used to include or exclude all events associated with a particular 
Blackboard Collaborate module. By default, all modules are included.

Note: The filtering options set in the Event 
Filtering Preferences panel always override 
the filtering set in Module Event Filter.

To open the Module Event Filter menu, click on the 

 Module Event Filter button in the tool bar. To 
exclude events of a module, de-select the module name 
from the menu: Activity (messages related to the 
commands you enter in Command input field, such as 
usage tips and error messages), Application Sharing, 
Audio, Chair, Chat, File Transfer, Interaction, 
Multimedia, Participants, Quiz Manager, Recorder, 
Timer, Video and Whiteboard. 

To turn display of a module’s events back on, select the 
module name again.

Note: To display some but not all events 
associated with a module, use the Event 
Filtering Preferences panel. For details, 
refer to Event Filtering Preferences Panel 
on page 43.

Importance Event Filter

The Importance Event Filter is a menu that enables you to 
filter events based on what is important or relevant. It also 
has an option to turn off/on the time stamps that appear in 
the Event panel.

Note: Hide Notifications and Hide My Events 
operate independently from All Events, Common 
Events and Important Events. For example, if 
you hide your own events, they will not be 
displayed even if you have selected All Events.
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Note: You can pick only one of All Events, Common Events or 
Important Events.

To open the Importance Event Filter menu, click on the  Importance Event Filter button 

in the tool bar. The menu has the following options:

 n Show Notifications − Notifications are system messages sent by Blackboard Collaborate to 
alert users when certain events occur: user joined or left the session, Moderator privileges 
granted, Timer expired and Chat announcement sent or received. By default, notifications 
will be displayed in your Event panel. If you don’t want Notifications displayed in your 
Event panel, select Hide Notifications. The menu item will change to Show Notifications; 
select this to turn display of Notifications back on. 

Note: The Hide/Show Notifications option affects what is 
displayed in your Event panel only. It will not affect whether or not 
a Visual Notification is shown in its own floating window; that is set 
in the Visual Notifications Preferences panel (see Visual 
Notifications on page 63). Conversely, what is set in the Visual 
Notifications Preferences panel will not affect what is displayed in 
the Event panel.

 n Show My Events − By default, the events that you triggered (e.g., raise your hand or turn 
on your microphone) will not be displayed in your Event panel. (They may, however, be 
displayed in the event panel of others, depending on the event.) If you want to display 
these events in your own Event panel, select Show My Events. The menu item will 
change to Hide My Events; select this to turn display of your events back off.

 n All Events − By default, events of all importance are displayed in the Event panel. If you 
don’t want to see all events, select either Common Events or Important Events.

 n Common Events − Select this option to display all events except the interaction events: 
Raise Hand/Lower Hand, Stepped Away/Came Back buttons and the emoticons Laughter, 
Applause, Confusion and Disapproval. 

 n Important Events − Select this option to display only a small subset of events, such as 
when a user has joined a session, when you have been granted the Moderator privilege or 
when you have received a Chat message.

 n Hide Times − Select this option to turn off/on the time stamps that appear in the Event 
panel. For further details, see Showing/Hiding Time Stamps on page 44
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Event Filtering Preferences Panel

If you want to filter events at a greater level of granularity than is offered by the Module Event 
Filter, you can do so in the Event Filtering Preferences panel. Here you can pick and choose 
which individual events in a particular module you want to be displayed in the Event panel.

 1. Open the Preferences dialog in one of the following ways:

 o From the Edit menu, select Preferences… (Windows & Linux) 

From the Blackboard Collaborate web conferencing menu, select Preferences 
(Mac OS X)

 o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

 2. In the left pane of the Preferences dialog, under Activity select              Event Filtering. The 
Event Filtering preferences panel appears. The events are listed according to the module 
to which they belong. Each event has a drop-down menu from which you can select the 
option to display the event Normally, Always or Never. 
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 3. Select the desired option for each of the events listed under the module names. Normally 
is the default option.

Note: The filtering set in the Event Filtering Preferences panel 
always overrides the filtering set in the Activity Window menus. 
For example, if you turn off the Audio module events in the Activity 
Window but have Microphone turned on set to display Always in 
the Preferences panel, whenever you turn on your microphone in 
the session, the event will be reported in the Events panel.

 l Normally – Select this option if you would like to use the filtering defined by the 
Activity Window’s Module and Importance Event Filters.

 l Always – Select this option if you would like to always display this event, even if it 
has been excluded from display by the Activity Window’s Module and Importance 
Event Filters.

 l Never – Select this option if you would like to never display this event, even if it has 
been included for display by the Activity Window’s Module and Importance Event 
Filters.

 4. Click on OK to save your preferences and close the Preferences dialog, Apply to save 
your preferences and leave the Preferences dialog open or Cancel to close the Preference 
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate web conferencing will remember the 
settings each time you join another session on the same computer. 

Resizing Activity Window Text
By default, the text in the Activity Window is determined by your operating system (typically 10 
or 11 points). 

 l To make the text larger, right-click (Control-Click on Mac) anywhere in the Activity 
Window to open the context menu and select Make Text Bigger.

 l To make the text smaller, right-click (Control-Click on Mac) anywhere in the Activity 
Window to open the context menu and select Make Text Smaller.

 l To return the text to the default size, right-click (Control-Click on Mac) anywhere 
in the Activity Window to open the context menu and select Default Size.

Showing/Hiding Time Stamps
By default, the Event panel displays a time stamp every 5 minutes. Any events that occur in the 
next five minute period will appear beneath that time stamp in the Event panel. For example, a 
time stamp will be reported at 1:00 PM and any events that occur between 1:00 PM and 1:05 
PM will be listed beneath the 1:00 PM time stamp. If there is no activity in a 5 minute period, 
(for example, between 1:05 PM and 1:10 PM), no time stamp will be reported for that period (for 
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example, 1:05 PM will not be reported). (This scenario is illustrated in the left screen capture 
below.) The next time stamp displayed will be for the next five minute period in which events 
occurred. 

If you want to hide the time stamps in the Event panel, select Hide Time from the Importance 
Event Filter. The menu item will change to Show Times; select this to turn the display of times 
back on. (The right screen capture above shows the Activity Window with time stamps hidden.)

Reading Events with a Screen Reader
A screen reader will not automatically read an event as it appears in the Activity Window. To be 
notified that an event has just been added to the Activity Window, turn on the Audible 
Notification Activity Event Occurred. (For instructions, see Audible Notifications on page 61.)

When a new event is reported, keyboard focus stays at the place you last had it (the last cursor 
position is maintained and the window will not scroll to the new message at the bottom). You 
need to manually move focus to the new event using your arrow keys so your screen reader can 
read the new text.
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Entering Commands
The Activity Window enables you to perform simple functions through the Command Input 
field. This field is normally hidden. 

To enter a command, do the following:

 1. Open the Command Input field in one of the following ways:

 o Click on the  Show/Hide Command Input field button in the tool bar.

Note: The field will remain open until you click on the 
Show/Hide Command Input field button again.

 o Type / (forward slash). The /, which is the first character required to enter a 
command, will be entered into the Command Input field.

Note: The field will close after you have entered your 
command and pressed Enter or Return.

 2. Enter a / (if not already there) followed by your command. For a list of the commands 
and their syntax, refer to Live Session Commands on the facing page and Recording Play-
back Command on page 48.

 3. Press Enter or Return to process the command.

If the command is unknown, has an unknown or invalid parameter or an error occurs while 
processing the command, a message to that effect will be displayed in the Event panel. If the 
command is successful, nothing is displayed.

Note: After the command has been processed, focus returns to the Event 
panel.

Tip: The Command Input field can be resized, if desired, by dragging the 
divider between it and the Event panel with your mouse.
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Live Session Commands
These commands can be used only in a live session, not while listening to a recording.

Each command starts with a / (forward slash) and is followed by parameters. Where there is 
more than one available parameter, they are listed together and separated by a | (pipe). Enter 
only one parameter. 

Raise or Lower Hand

Syntax: /hand up|down

Set Audio Mode 

Syntax: /audio computer|phone

Talk or Stop Talking

Syntax: /talk on|off

Send Chat Message

Syntax: 

/chat <message> 

where

 n <message> is the text of your message 

Note: use this syntax to send a public message to only the room you are currently in.

or

/chat [@<recipient> | @all_rooms | @announcement | @moderators] <message>

where 

 l <recipient> sends a private message to the specified Moderator or Participant

 l all_rooms sends a public chat to all rooms (Main room and breakout rooms)

 l announcement sends a public message as an Announcement

 l moderators sends a message to Moderators only (under the Moderators conversation tab)

These options are not case-sensitive. 

47The Activity Window



Tip: Enclose <recipient> in quotation marks if it contains an ambiguous 
term. For example, let’s say there are two Participants, one named Mary 
and one named Mary Hansen. If you want to send Mary Hansen the 
message “Hello Mary”, enclose her name in quotation marks:
      /chat @“Mary Hansen” Hello Mary 
If you enter 
      /chat @Mary Hansen Hello Mary 
you will send the other Mary the message “Hansen Hello Mary”.

<message> is the text of your message. 

Display Video

Syntax: /video preview|on|off

React (show emotion)

Syntax: /react laughter|applause|confusion|disapproval|approval|faster|slower 

Enter Polling Response

Syntax: /answer none|yes|no|a|b|c|d|e

Step Away or Come Back

Syntax: /status away|back

Recording Playback Command
This command can be used only while listening to a recording. It starts with a / and is followed 
by one of three parameters, listed together and separated by a | (pipe). Enter only one 
parameter.

Syntax: /playback start|pause|stop
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Closed-Captioning
Closed-Captioning is an accessibility feature of Blackboard Collaborate that enables session 
attendees to transcribe audio information for deaf and hard of hearing attendees while a session 
is in progress. The transcribed text can be viewed by other session attendees in the live session 
and in a recording of the session. It can also be saved to a text file. 

There are two types of Closed-Captioning windows: one for entering closed-captioning text 
(input window) and one for reading the text (view-only window). 

Note: Closed-Captioning windows always stay on top of other windows so 
they are easily accessed. 

Anyone in the session can view the closed-captioning text, but a Moderator must give session 
attendees the permission to enter closed-captioning text. More than one person may be given 
permission to enter closed-captioning text.



Closed-Captioning Activity and Permission Indicators
You can monitor the state of Closed-Captioning activity and permissions through  indicators 
displayed in the  Participants list of the Participants panel. 

The following table describes the icons displayed in the Participant list to indicate Moderator 
and Participant permissions and activity while using Closed-Captioning.

Activity 
Indicator

Meaning

User is currently entering Closed-Captioning text.

Moderator has granted Closed-Captioning permission to this user.

Entering Closed-Captioning Text
Once you have been given permission to enter the closed-captioning text, open the Closed-
Captioning input window by doing one of the following:

 o Click on the  Closed-Captioning button at the top of the Audio & Video panel.

 o From the Window menu, select Show Closed-Captioning.

Place your cursor in the input window (below [Enter captions text]) and start typing (or paste 
text). 

The Closed-Captioning window also enables you to do the following:

 l change window display options (see Window Display Options on page 53

 l save the closed-captioning text (see Saving Closed-Captioning Text on page 52)
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Viewing Closed-Captioning Text
All Moderators and Participants, upon joining a session have the permission to view the text in 
the Closed-Captioning window. To open the  Closed-Captioning view-only window, do one of 
the following:

 o Enter Control+F8 (Command-F8 on Mac).

 o From the Window menu, select Closed-Captioning.

 o If someone in the session has been granted the permission to enter captions, you will see 
the  Closed-Captioning button at the top of your Audio & Video panel. Click on it to 
open the view-only window.

If no one is currently entering closed-captioning text, the Closed-Captioning window will state 
[No caption source available].

If someone is entering closed-captioning text, the Closed-Captioning window will display who is 
entering the Closed-Captioning text in the Source menu. In the example below, Lucy entered the 
text.

Note: The view  window keeps a history of the captions. If you close and 
reopen it, it will retain the captions that you received when the window 
was previously open. It will not, however, display any captions entered by 
a captioner while you had the window closed. 

51Closed-Captioning



The Closed-Captioning window enables you to do the following:

 l read closed-captioning text;

 l change the closed-captioning source (see Viewing Closed-Captioning Text on page 51);

 l change window display options (see Window Display Options on page 53

 l save the closed-captioning text (see Saving Closed-Captioning Text on page 52).

Changing the Closed-Captioning Source
If more than one person in the session is entering closed-captioning text at the same time 
during the session,  all their names will appear in the Preferred Source drop-down menu. To 
change whose closed-captioning text you want to read, click on the drop-down arrow button and 
then select the desired person. 

If the source is set to None (such as when you first open the view-only Closed-Captioning 
window), the first person who starts entering closed-captioning text automatically will become 
the source. 

Tip: You also can tell who is currently entering Closed-Captioning text by 
the presence of  the  Closed-Captioning icon next to the captioners' 
names in the Participants list.

If your selected (preferred) captioner leaves the room, you will receive the captions of the next 
captioner in the list (if there is another captioner). If your preferred captioner returns to the 
room, you will receive their captions  once again. 

Saving Closed-Captioning Text
You can save the closed-captioning text by selecting Save from the Options 
menu in either of the Closed-Captioning windows (input or view). 

Each time you close the Closed-Captioning window a new transcript is 
started, so only the captions that were entered since the last time you 
opened the window will be saved. 
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Window Display Options
In both Closed-Captioning windows (captioner's input window and reader's view-only window) 
you can customize the display of the window by changing the font, size and color of the text and 
the color of the background. 

Note: Blackboard Collaborate web conferencing will remember these 
setting each time you join a session from the same computer.         

The following options are available:

 n Background Color – To change the background color in the window, click on the 
Background Color square  to open the color picker. The default color is white. The new 
color you select will be displayed in the square.

 n Text Font – To change the font of the caption text, click on the Text Font drop-down 
menu arrow and select the desired font. The default font is Dialog. 

 n Text Size – To change the size of the caption text, click on the Text Size drop-down 
menu arrow and select the appropriate font size. The default text size is 24. 
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 n Text Color – To change the color of the caption text, click on the Text Color square to 
open the color picker. The default color is black. The new color you select will be 
displayed in the square.

 n Invert – To reverse the text and background colors, select Invert from the Closed-
Captioning Options menu.

In our current example, the dark blue text will become light blue and the light blue 
background will become dark blue.

Closing and Reopening the Closed Captioning Window
Input window: As the writer of captions, when you close the caption input window, it will be 
cleared of all content. When you reopen it, it will be blank. 

View-only window: As the reader of captions, when you close the view  window, it will keep a 
history of the captions. When you reopen it, it will contain the captions that you received when 
the window was previously open. It will not, however, display any captions entered by a 
captioner while you had the window closed.
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To close the window, do one of the following:

 o Click on the  Closed-Captioning button at the top of your Audio & Video panel. 

 o Click on the window’s Close button in the title bar of the window.

 o Enter Ctrl+W (Command-W on Mac) 

 o Enter Alt+F4 (Windows and Linux only)

To reopen the window, do one of the following:

 l Click on the  Closed-Captioning button at the top of your Audio & Video panel. 

 o Enter Ctrl+F8 (Command-F8 on Mac).

 o From the Window menu, select Closed-Captioning.
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Accessibility Options
Several options and preferences  exist in Blackboard Collaborate web conferencing  to improve 
accessibility. See the following sections for details:

 l Setting Notification Preferences on page 61

 l Application Sharing Options on page 65

 l Changing the Chat Text Size on page 68

 l Changing the Notes Text Size on page 70

Managing Audio
The following sections describe the Audio accessibility features.

Using the Audio Setup Wizard
 The Audio Setup Wizard is a tool you can use to verify that your Audio is set up correctly. It is 
comprised of a series of panels that guide you through selecting Audio input (microphone) and 
output (speaker) devices and setting your speaker and microphone volumes.     We encourage 
everyone to run the wizard prior to the start of the session.



Tip: To run the Audio Setup Wizard before your session begins, either join your session early 
or open the Configuration Room on the Blackboard Collaborate Support Portal: 

       http://support.blackboardcollaborate.com

To open the Configuration Room, browse to  First Time Users and then to Step 2 under 
Blackboard Collaborate Web Conferencing. 

You can run the Audio Setup Wizard again at any time within your session. 

Note: When you are using the Audio Setup Wizard during a session, you 
will not be able to hear any of the session Audio. Others will know you 
can't hear them because the Audio Setup Wizard icon  will appear next 
to your name in the Participants list. 

To open the Audio Setup Wizard, do one of the following:

 o Click on the Audio Setup Wizard button at the top of the Audio & Video panel.

 o From the Tools menu select Audio and then Audio Setup Wizard. 

 o From the Audio & Video Options menu, select Audio Setup Wizard. 

On Windows or Linux

 1. Select your audio output device (speakers), following the instructions given in the dialog 
box.

 2. Play the recorded audio message provided and adjust your speaker volume to a suitable 
level. (Follow the instructions given in the dialog box.)

 3. Confirm whether or not your speaker was set to an appropriate level. 

 n If you clicked on Yes, go to step 4.

 n If you clicked on No, you are prompted to try again or cancel. Click on Try Again 
to go back to step 1. 

 4. Select an audio input device (microphone), following the instructions given in the dialog 
box. 

 5. (Linux only) Select your microphone type to get the best results when testing your 
microphone. 

 n Single Talker: Select this option if using a headset or a microphone just for your-
self. 

 n Multiple Talkers: Select this option if using a single microphone to pick up multiple 
talkers, such as when you are in meeting room sharing the microphone with others. 
This is the default.      
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 6. Press Record and adjust your microphone recording level as you speak into the micro-
phone (audio input device). (Follow the instructions given in the dialog box.) Press Stop 
when you are done.

 7. Press Play to listen to the recording you just made and, based on the loudness and clarity 
of the recording, determine if your microphone was set to an appropriate level.

 8. Confirm whether or not your microphone was set to an appropriate level. 

 n If you clicked on Yes, go to step 8.

 n If you clicked on No, you are prompted to try again or cancel. Click on Try Again 
to go back to step 4.

 9. Read the message in the dialog box and click on OK to complete Audio setup and exit the 
Audio Setup Wizard.

On Mac OS X

 1. Mac users cannot change their audio output (speaker) devices directly in Blackboard Col-
laborate web conferencing – Blackboard Collaborate uses the system default device. To 
change your output device, click on the speaker icon in the Select Audio Output Device 
dialog of the Audio Setup Wizard and make your changes in the System Preferences 
Sound Output panel. When done, click on OK to advance to the next panel of the wizard.

 2. Play the recorded audio message provided and adjust your speaker (audio output device) 
volume to a suitable level. (Follow the instructions given in the dialog box.)

 3. Confirm whether or not your speaker was set to an appropriate level. 

 n If you clicked on Yes, go to the next step.

 n If you clicked on No, you are prompted to try again or cancel. Click on Try Again 
to go back to step 1.

 4. Select an audio input (microphone) device from the list or select the option Use System 
Default Device. Follow the instructions given in the dialog box. 

 5. (Mac OS X 10.5 and earlier only) Select your microphone type to get the best results when 
testing your microphone. 

 n Single Talker: Select this option if using a headset or a microphone just for your-
self. 

 n Multiple Talkers: Select this option if using a single microphone to pick up multiple  
talkers, such as when you are in meeting room sharing the microphone with others. 
This is the default. 

 6. Press Record and adjust your microphone recording level as you speak into the micro-
phone (audio input device). (Follow the instructions given in the dialog box.) Press Stop 
when you are done.

 7. Press Play to listen to the recording you just made and, based on the loudness and clarity 
of the recording, determine if your microphone was set to an appropriate level.
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 8. Confirm whether or not your microphone was set to an appropriate level. 

 n If you clicked on Yes, go to the next step.

 n If you clicked on No, you are prompted to try again or cancel. Click on Try Again 
to go back to step 3.

 9. Read the message in the dialog box and click on OK to complete Audio setup and exit the 
Audio Setup Wizard.

 

Adjusting Microphone and Speaker Levels
The microphone level indicator (microphone icon) shows the volume levels when you are 
speaking and the speaker level indicator (speaker icon) shows the volume levels when someone 
else is speaking. 

Tip: If all talkers have their microphones set properly, listeners won’t 
need to keep adjusting their speakers to accommodate changes in volume. 
The best way to ensure proper microphone and speaker levels is  to run 
the Audio Setup Wizard at the beginning of the session. See Using the 
Audio Setup Wizard on page 57.

Microphone Level

There are four ways to adjust your microphone level:

 o Audio & Video panel: Grab the microphone level slider in the Audio & Video panel and 
drag it to the right to increase the volume and to the left to decrease the volume. 

 o Options menu: From Audio & Video Options menu, select either Adjust Microphone 
Level Up (to increase the volume) or Adjust Microphone Level Down (to decrease the vol-
ume).

 o Tools menu: From the Tools menu, select Audio and then select either Adjust Micro-
phone Level Up (to increase the volume) or Adjust Microphone Level Down (to decrease 
the volume).

 o Keyboard Shortcuts: Enter Ctrl+Shift+Up Arrow (Shift-Command-Up Arrow on Mac) 
to increase the volume or Ctrl+Shift+Down Arrow (Shift-Command-Down Arrow on Mac) 
to decrease the volume.
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Speaker Level

There are four ways to adjust your speaker level:

 o Audio & Video panel: Grab the speaker level slider in the Audio & Video panel and 
drag it to the right to increase the volume and to the left to decrease the volume. 

 o Options menu: From Audio & Video Options menu, select either Adjust Speaker Level 
Up (to increase the volume) or Adjust Speaker Level Down (to decrease the volume).

 o Tools menu: From the Tools menu, select Audio and then select either Adjust Speaker 
Level Up (to increase the volume) or Adjust Microphone Speaker Down (to decrease the 
volume).

 o Keyboard Shortcuts: Enter Ctrl+Up Arrow (Command-Up Arrow on Mac) to increase 
the volume or Ctrl+Down Arrow (Command-Down Arrow on Mac) to decrease the vol-
ume.

Setting Notification Preferences

Audible Notifications
Audible notifications are system messages sent by Blackboard Collaborate web conferencing to 
notify users when certain important events occur within the session. These notifications are 
presented as sounds. 

Note: The implementation of audible notifications on mobile devices is 
different than what is described here. For a list of features supported on 
mobile devices, see       the Moderator's Guide.

In the Preference dialog, you can listen to what each notification sounds like as well as enable or 
disable the notifications. There are two built-in sets of notifications: Basic and All. 
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 1. Open the Preferences dialog in one of the following ways:

 o From the Edit menu, select Preferences… (Windows & Linux) 

From the Blackboard Collaborate web conferencing menu, select Preferences 
(Mac OS X)

 o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

 2. In the left pane of the Preferences dialog, under General select Audible Notifications. The 
Audible Notifications preferences panel appears on the right side of the main Preferences 
dialog. 

 3. To hear the sound used for a notification, click on its Preview icon  in the right column 
of the panel.

 4. Enable and disable the notifications for the various events in the following ways.

 o To create a custom set of notifications, click on the Enabled checkbox (middle col-
umn) associated with the desired individual events.

 o Click on the Basic button at the bottom of the panel to select the Hand Raised 
Alarm, Recording in Progress, Start Recording, Stop Recording and Timer Alarm 
events. This is the default setting.

 o Click on the All button at the bottom of the panel to select all events.
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 5. Click on OK to save your preferences and close the Preferences dialog, Apply to save 
your preferences and leave the Preferences dialog open or Cancel to close the Preference 
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate web conferencing will remember the 
settings each time you join another session on the same computer. 

Visual Notifications
Visual notifications are system messages sent by Blackboard Collaborate web conferencing to 
alert users when certain important events occur within a session. These notifications are 
presented in a floating window. Multiple notifications get queued: the first one is displayed until 
it times out or you dismiss it (by clicking on the Dismiss button in the bottom right corner of 
the notification), then the next one is displayed, and so on. When there is more than one 
notification, the window will have a Dismiss All button beside the Dismiss button and 
display the number of notifications in the queue in the bottom left corner of the notification.

Note: The implementation of visual notifications on mobile devices is 
different than what is described here. For a list of features supported on 
mobile devices, see       the Moderator's Guide.

You can judge how long the message will remain open by looking at the Timeout Indicator. You 
either can dismiss a notification manually (by clicking on the Dismiss button) or wait for it to 
close itself automatically (when the Timeout Indicator runs its course). 

1 Timeout Indicator 

2 Number of notifications in the queue

3 Dismissal buttons

In the Preference dialog, you can enable or disable the notifications. By default, all notifications 
are enabled.

 1. Open the Preferences dialog in one of the following ways:

 o From the Edit menu, select Preferences… (Windows & Linux) 

From the Blackboard Collaborate web conferencing menu, select Preferences 
(Mac OS X)
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 o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)

 2. In the left pane of the Preferences dialog, select Visual Notifications under General. The 
Visual Notifications preferences panel appears on the right side of the main Preferences 
dialog. 

 3. Enable and disable the notifications for the various events as desired by 
selecting/deselecting the checkboxes in the Enabled column on the right side of the panel.
 

Note: The changes you make in the Visual Notifications 
Preferences panel will not affect what is displayed in the Event 
panel of the Activity Window.                              

 4. Click on OK to save your preferences and close the Preferences dialog, Apply to save 
your preferences and leave the Preferences dialog open or Cancel to close the Preference 
dialog without saving any of your changes.
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When you configure preferences, Blackboard Collaborate web conferencing will remember the 
settings each time you join another session on the same computer. 

Application Sharing Options
The following sections describe Application Sharing features that improve accessibility for low 
vision and color blind users.

Viewing a Shared Application 
Application Sharing is displayed in the Content area, which contains an Application Sharing 
Action bar in the upper left corner. For Participants without the Application Sharing 
permission, the bar contains the Scale to Fit option only (see Viewing a Shared Application  
above).

Participants who have the Application Sharing permission have the additional option Request 
Cursor Control. For information on this feature refer to Requesting Control of an Application 
Share from the Host.

Scaling the Shared Content

The application or desktop area shared by the Host can be scaled to fit the Content area (the 
default) or viewed at its native size (same size as the Host).

To view the content at the same size as the Host, do one of the following:

 o Uncheck Scale To Fit in the Action bar. 

 o From the Tools menu, select Application Sharing and then uncheck Scale to Fit.

To restore scaling, recheck Scale To Fit.

Maximizing the Content Area

Another option you have for viewing an Application Share is to resize the Content area. 

You can optimize the space available in the Content area in two ways; for maximum space, do 
both: 

 o Maximize your Blackboard Collaborate web conferencing window.

 o Hide the side bar (Audio & Video, Participants and Chat panels) by unselecting           Show Side 
Bar in the View menu or by grabbing  the border of any one of the panels and dragging it 
all the way to the left.

To restore the side bar, reselect          Show Side Bar or drag the panel border back to the right.
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Emphasized Cursor

If the application host has turned on the option Emphasize Cursor, you will see their cursor 
surrounded with a circle (the default color is yellow), making it easier for you to follow. 

Hosting Options
The Hosting Options dialog box allows you to define how to display the Blackboard Collaborate 
web conferencing Application Sharing window while you are hosting an Application Sharing 
session. 

To change the Hosting Options in the Preferences dialog, do the following:

 1. Open the Preferences dialog in one of the following ways:

 o From the Edit menu, select Preferences… (Windows & Linux) 

From the Blackboard Collaborate web conferencing menu, select Preferences 
(Mac OS X)

 o Enter Ctrl+Comma (Windows & Linux)

Enter Command-Comma (Mac OS X)
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 2. In the left pane of the Preferences dialog,  select Hosting Options under Application 
Sharing. The Hosting Options preferences panel appears.

 3. Change any options:

Hide content area – Select this option to collapse the Content area of the Black-
board Collaborate interface, leaving only the sidebar visible.

Shared region highlight color – Use this option to set the color of the border sur-
rounding your shared application. The border identifies what is being shared so you 
will always know what the viewers of your application share are seeing

Raise shared applications to front – Select this option if you want the application 
that is being shared to be brought to the front of all other windows. If the option is 
not selected, the application may be hidden behind other windows on your monitor 
and the Application Sharing window will be black.

Linux Note: This option does not work on Linux using KDE 
or Gnome. 

Emphasize cursor – Select this option if you would like the cursor in your shared 
application to stand out so it is easier for viewers of the shared application to follow 
its movements. If set, the viewer’s cursor will be surrounded by a colored circle. (As 
host, your view of the cursor is not emphasized.) Click the colored box to the right 
to change the highlighter color.

Show a notification – Select this option if you want a Notification window to appear 
on your monitor every time you start hosting an Application Sharing session. If you 
wish not to have this window appear, de-select this option.
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 4. Click on OK to save your preferences and close the Preferences dialog, Apply to save 
your preferences and leave the Preferences dialog open or Cancel to close the Preference 
dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate web conferencing will remember the 
settings each time you join another session on the same computer. 

Chat Options
The following sections describe the Chat features that improve accessibility for low vision and 
blind users.

Changing the Chat Text Size
You can set the font size of the text in the conversation pane anywhere from  7 points  to 109 
points, in increments of 2 points. The default value is 13 points, which may be influenced by 
your system-wide font defaults.

To increase the font size, do one of the following

 o From the Tools menu, select Chat and then Increase Font Size.

 o From the Chat Options menu, select Increase Font Size.

To decrease the font size, do one of the following

 o From the Tools menu, select Chat and then Decrease Font Size.

 o From the Chat Options menu, select Decrease Font Size.
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Adding Emoticons to your Chat Message
Emoticons are special graphical icons that you can insert into any text-based chat to make your 
conversations more expressive and fun.

You can add emoticons to your Chat messages by selecting them from the Chat Emoticon menu 
or by entering text strings in the Chat message text field. The text string equivalent of the 
emoticon selected in the Emoticon menu is displayed in the bottom left corner of the menu.

Note: If you do not see the Chat Emoticon menu, it means a Moderator 
has disabled Chat emoticons. You can still type the text string equivalents 
of emoticons  in the message text box but they won't be converted to 
icons. For example, when you type ;-), others in the session will see ;-) 
rather than .

The following table lists a few of the most popular emoticons and their respective text strings. (A 
full list of the text strings used for entering emoticons is available in      .) 

Note: The emoticon text strings are not case sensitive, so you can use 
either upper case or lower case letters to enter your emoticons.
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Emotions Icons Text strings

Smiley :) or :-)

Wink ;) or ;-)

Sad :(   or   :-(

Surprised :-o   or   :-O  

Confused :/ or   :-/

Grin :D or :-D

Angry :@ or :-@

Thumbs up (y)

Thumbs down (n)

Changing the Notes Text Size
You can change the size of the text displayed in the Notes editor to make it more readable for 
you. The font size of the entire document will change and any changes that were made using the 
Decrease and Increase keyboard shortcuts will be overridden.
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The available text sizes are 8, 9, 10, 11, 12, 13, 14, 15, 16, 18, 20, 22, 24, 28, 32 and 36 points. To 
change the font size of the text, do one of the following:

 o Select the font size from the Text Size menu in the tool bar of the Notes window.

 o Right click (Control-Click on Mac) anywhere in the Notes 
editor and select one of the options from the context 
menu.

Make Text Bigger – increase the text size to the 
next larger size. For example, if the text was set to 
12, selecting Make Text Bigger will increase the size 
to 13.

Make Text Smaller –decrease the text size to the 
next smaller size. For example, if the text was set to 
36, selecting Make Text Smaller will decrease the 
size to 32.

Default Size –set the text size back to the default 
setting of 12. (This value may be different for non-
English implementations of Blackboard Collaborate 
web conferencing.)

Text Size – change the text size to that selected 
from the submenu.
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Appendix A: 

Page 73

Chat Emoticon Text Strings
The following table shows the text strings that can be used to enter emoticons. The emoticon 
text strings are not case sensitive, so you can use either upper case or lower case letters to enter 
your emoticons.

Emotions Icons Text strings

Smiley :) or :-)

Wink ;) or ;-)

Sad :(   or   :-(

Eye roll (re)

Cool (shades) B)   or   B-) 

Tongue (sticking 
out)

:P or :-P

Surprised :O   or   :-O  

Crying :'(

Confused :/ or   :-/



Emotions Icons Text strings

Grin :D or :-D

Angry :@ or :-@

Evil grin (6)

Kiss (lips) :* or :-*

Heart <3

Broken heart </3

Lightening (shazam)

Report (p)

Email (envelope) (e)

Open book (s)

Book (ns)

Chart (#)

Clock (+)

Coffee (c)

Birthday cake (hb)

Telephone (t)

Television (tv)

Music (notes) (m)

Computer (01)

iPod (i)

Game (controller) (g)

Webcam (w)

Bat :[

Man (z)

Woman (x)

Group (of people) (f)
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Emotions Icons Text strings

Credit card (cc)

Money (dollar bill) ($)

Alert (caution sign) (!)

Eye (eye)

Car (a)

Male (symbol) (xy)

Female (symbol) (xx)

Soccer ball (1)

Football (2)

Basketball (3)

8 Ball (8)

House (h)

Sleep (ZZZs) (zz)

Thumbs down (n)

Thumbs up (y)

Sun (su)

Cloud (ts)

Rain (rn)

Snow (sn)

Rainbow (r)

Star (*)
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Blackboard Collaborate Copyright
This document contains confidential proprietary information and is protected by law.  This 
document and the information contained in it are intended for authorized users only and may 
be used only for the express purpose of legally accessing and using Blackboard Inc. products; any 
other use, without Blackboard Inc.’s prior written permission, is strictly prohibited. 

 

© 2013 Blackboard Inc. All Rights Reserved.

 

 

Trademarks
Blackboard, the Blackboard logo, Blackboard Collaborate, the Blackboard Collaborate logo, 
Behind the Blackboard, Wimba and Elluminate are trademarks or registered trademarks of 
Blackboard Inc. or its subsidiaries in the United States and/or other countries. All rights 
reserved.

All other brand or product names are trademarks or registered trademarks of their respective 
companies or organizations.
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